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Digital Photo Necessities 
 

Introduction 
 
You just bought yourself a brand new digital camera and now 
what? It came with a 32MB memory chip and the shop 
convinced you to buy a 512MB one. You really have no idea 
what to do next, except know how to press the button and 
preview the image. 
 
Digital photography is different from regular photography. 
You do not need to develop film and do not need to keep 
negatives in a safe place. Instead we store our photos on the 
computer! Like with negatives, you still like to keep these 
originals safe and together, and in a spot where you can find 
them again years later if necessary. How do we do that? 
 
And if we don’t get the pictures printed how do we share them 
around? How do I put them in my wallet or send them up to 
friends? All that has changed with digital photography. No 
longer do we need pen and paper to mail each other, most of 
us now use e-mail and websites to share our photos. We will 
also learn how to do that in this course! 
 
Taking your negatives to the printers is all different now too. 
Instead of locating your negatives you now locate the photos 
you like to get printed and transfer them back to either your 
camera or to a memory stick or CD/DVD and that you take to 
the store for printing via the fancy machines there. 
 
Sometimes you have photos that would have been great if 
only... With digital photos we can actually fix the photos, 
something we could not easily do with old fashioned film. The 
camera probably came with lots of software that would let you 
manipulate your photos, improve on them or make them into 
calendars or greeting cards. The nice printers we all have are 
very capable of printing high quality prints! 
 
But let us begin  with the basics: 
 

Hardware 
Computers come in many shapes and sizes. For image 
processing we do not require huge processing power, but it is 
all relative. The only real requirement we have for digital 
photography is oodles and oodles of disk 
space. Google only recommends the 
following for minimum specifications for 



Picasa, the software we will be primarily using: 
(http://picasa.google.com/features/requirements.html): 

·  PC with 300MHz Pentium® processor and MMX® 
technology. 

·  64 MB RAM (128MB Recommended) 
·  50 MB available hard disk space (100MB recommended) 
·  800 × 600 pixels, 16 bit colour monitor. 
·  Microsoft® Windows 2000, or Microsoft® Windows XP.* 
·  Microsoft® Internet Explorer 5.01 or better (6.0 

recommended). If at any time you get an ‘unable to 
authenticate’ error, you should upgrade to IE 6.0. 

·  Microsoft® DirectX 7.0 or higher (8.1 ships with XP, 9.0b 
recommended). 

·  Optional: 56K Internet connection speed or better (for access 
to any online services). 

In reality there is little excuse these days not to have. It will 
make for a more pleasant experience for all applications: 

·  Windows XP – Service Pack 2 
·  512MB RAM (ideal for Windows XP). 
·  5000-10000 Megabytes (5-10 Gigabytes) of available hard 

disk space 
·  1024x768 pixels and 32bit colour monitor (at least 15’) 

Hard disks are easily added to a computer, and a spare 160GB 
hard disk drive can cost as little as $100 to add to your 
computer. Consider purchasing an external hard disk for 
photo/backup, you can also safely lock it away when you go 
on holidays. 
 
Just remember that a 5 megapixel camera makes photos that 
require 1-2MB per photo. Considering you can take 500 
photos in a one week holiday that equates to up to a Gigabyte 
of space! 
 

As for camera choice most cameras are excellent these days 
for printing up to an easy A4 size print. Look out for these 
specifications: 
 

·  good optical zoom (minimum of 3x optical zoom) 
·  4 mega pixel minimum resolution 
·  Regular sized rechargeable batteries (ie. AA or AAA) or a 

spare battery if it is a special size battery (I always carry a 
spare set of charged ones with me). 

 
Exercise: 
What kind of computer have you got at home? How old is it? 



_______________________________________ 
 
Do you know which operating system you have (Windows 98 
or Macintosh…)?  
_______________________________________ 
 
Extra question: How big is your hard disk? How much space 
is available on it? 
_______________________________________ 

 
 

Provided Software 
The CD/DVD that came with the camera has more then just 
the required software to get your camera connected to the 
computer. It has much more! Do we need all this? That 
depends on what you have on your computer. Many of us 
already have software we like to use with our photos, and if 
you are happy with that you may not wish to change that. 
Installing the software that came with the camera will override 
most old software, which means that when you double click 
on a photo file it will open up the new software. This can be 
frustrating if you already spent months learning another 
software package. 
 

 
Kodak supplies a comprehensive, and very invasive, software package with 
their cameras.  
 
Most cameras connect to the PC with a USB cable, and most 
modern operating systems will recognise the camera without 
you having to install anything at all. If this is the case you 
might like to wait installing any of the supplied software and 
see how you go without it. 
 
You may prefer to use software that you are learning about, 
and the chance of that being on the CD is slim. The software 
you get for free with your camera is generally fine to use, but 
they all differ from package to package. Generally the 
software supplied is a ‘lite’ version and you are encouraged to 
buy the full version later. Because there are many different 



software packages around this means help is hard to find and 
you just need to deal with the steep learning curve on your 
own. In this course we will all use Google’s free imaging 
software solution Picasa.  
Picasa by default will monitor your system for your camera 
connection and offer to add newly found pictures to your 
existing collection. It allows you to enhance, email and post 
your photos with ease, create slideshows and make CDs etc. 
Picasa is not necessarily the only one or the best, but it is one 
that is easily accessible and free and is gaining in popularity! 
You can download it here: http://picasa.google.com. 
 

 
 
The more advanced imaging software that people talk about 
includes the likes of Adobe Photoshop. These are complicated 
and expensive applications and are beyond the scope of this 
course. If you happen to have Photoshop or similar on your 
computer, and like to continue using them the software 
provided with your digital camera is likely to be disappointing 
(mainly because they are the ‘light weight’ versions of the real 
thing). Remember that the professional software titles are 
generally more expensive than your camera. 
 
Exercise: 
Have you used photo software on your computer? If yes, 
which one? 
_______________________________________ 
 
Do you know which software came with your camera? If yes, 
which one?  
_______________________________________ 
 

Card Readers 
If you have a card-reader on 
your computer you can take 
the memory card from your 
camera and put it directly in 



the card-reader. It is very convenient as they fit multiple 
format cards. This means you can use it to get photos from 
most cameras on your computer without the need for cables.  
 
If a card-reader is not built into your computer it is relatively 
cheap to buy one. Buy them anywhere (from Woolworths to 
Tandys!) for under $50. They plug straight into your 
computer’s USB plugs and most computers do not need driver 
disks or software. Your memory cards will show up as 
multiple disk drives (e-drive, f-drive etc.). In some ways this 
is the preferable way to go as no more cables are required, we 
got enough cables everywhere!! Another advantage is that 
they do not use your camera’s batteries during transfer. 
 

Taking Digital Photos 
Taking pictures with a digital camera differs from a regular 
camera primarily in cost. To buy develop and print a roll of 
prints costs money, whereas digital photos cost nothing! You 
are limited only by the batteries and the memory chip you 
have. With fully charged batteries and a large memory card 
you can take hundreds of pictures virtually for free. Make sure 
you use this advantage. 
 
Out of every ten photos you might have one nice one, take 
hundreds and you might get a dozen really good ones! Make 
sure you carry your camera around whenever you can! Also 
remember now that cameras are more like computers you will 
want to update them every few years. They make great hand-
me-downs for the family! The more photos you take the more 
value you get out of your camera.  
 
Exercise: 
How many photos do you take in a month?  And on holiday? 
_______________________________________ 
 
How often do you see or share your old photos?  
_______________________________________ 

Batteries 
 
If you camera does not have a proprietary battery pack and 
uses AA or AAA batteries  there are many options for 
batteries and battery chargers. The best kind of battery to get 
to date is the Metal Hydride kind with a capacity of at least 
2500 mAh or 900mAh for the AAA sized batteries. These 
batteries will outlive the best alkaline batteries by a country 
mile and will save you lots in buying new batteries! 
 



mAh is a measure of a battery's energy storage capacity.  If 
you think of a battery as a small fuel storage tank, which in a 
sense it is, mAh a measure of how much ‘fuel’ the battery 
holds.  You can recharge them hundreds of times before they 
‘wear out’.  It is a good idea to carry a spare set of them at all 
times, but keep in mind that at room temperature they will 
loose approximately half their charge in one month even if not 
used!  
 
There are rapid chargers on the market advertising 15 minute 
charging times, but this may only work for the supplied 
batteries. My experience is that after completing a rapid re-
charge and then putting the newly charged batteries in a slow 
charger it still continues charging for most of the night before 
indicating a full charge. When buying a rapid charger look for 
a car adapter and if traveling overseas ensure the charger will 
accept 110-240V which means a simple power point adaptor 
will work for you when traveling in foreign countries. 
 
Should you have a custom battery it is a wise choice to buy a 
second battery pack because you cannot just buy some AAs in 
a store when you suddenly run out! 
 
More information is here: http://www.greenbatteries.com/ 
 
Exercise: 
What batteries came with your camera? 
_______________________________________ 
 
What batteries have you got now?  
_______________________________________ 
 
What can you tell me about your batteries?  
_______________________________________ 
 
Are you happy with your batteries?  
_______________________________________ 
 
Memory Cards 
Memory cards are just like any other kind of disk drive. They 
hold much more than the old fashioned floppy disk drive, and 
often hold more than the old ZIP disk for those who remember 
it. The kind of memory card you will probably require will 
hold as much as a CD. The card that comes with your camera 
is often only enough for a handful of pictures, not enough! 
Bigger is always better, and with most cameras a 512MB card 
is good minimum to buy. Today they are available from as 
low as $50. Good brands are important since you really want 
reliablility. Another factor is speed, although with current 



technology that is less of an issue. If you need to shoot movies 
with your still camera you may like to buy the ‘faster’ cards:  
 
When shooting digital pictures you can select to make lower 
resolution or more compressed photos, but that sacrifices 
quality. You bought the 6 mega pixel camera for the quality, 
so why shoot at any less? Change the resolution or 
compression if you think you are running out of space, but in 
general shoot in High Quality (H!) and least compression. 
Some cameras allow for RAW mode, but that is an awkward 
format for everyday shooting and takes up much more space 
on your card. 
 

Tips for improving your photos  
·  Avoid high contrast scenes; digital film is not as flexible with 

exposure as regular film. 
·  Consider using the flash to light up subjects even when you 

think it might not be needed 
·  Press the Macro button when shooting anything close, and 

avoid using the flash for macro shots. 
·  Learn to half press the shutter with the subject in focus, then 

frame the shot, and then push the shutter down fully. This 
ensures the subject is focused and well exposed. 

·  Avoid using the digital zoom in general. Zooming into a scene 
using a digital zoom is similar to cropping later on the 
computer. 

·  With fast moving subjects learn to use manual focus to pre-set 
the focus, and try moving the camera with the subject. 

·  Turn off the Date Function – your file should have a date on it 
in any case! 

·  KNOW YOUR CAMERA (read your manual!) 
·  Use a tripod when available and ensure natural lines like the 

horizon are straight (unless it is done on purpose). 
·  Anticipate the shot and shoot the picture keeping in mind the 

possible shutter lag noticeable in some digital cameras. 
 

Viewing pictures on TV 
 
 

 
 

The following content is largely copied from: 
http://picasa.google.com.au/support/  

Downloading and Installing Picasa 
1. Navigate to http://picasa.google.com 
2. Click on the Free Download button. 
3. Run (‘open’) the installer using the default settings. 



 
When you install Picasa, the software will commonly scan the 
entire contents of your computer. This scan generally includes 
folders where your browser's web cache is stored. This cache 
is the collection of files and images from web sites that have 
been visited. 
 
When Picasa performs a complete scan of your computer, it 
will also commonly scan folders where email attachments are 
stored, sometimes resulting in questionable images. 
 
Next you will see the regular Picasa window showing your 
photos – see figure below. 
 

 

Transferring from camera to PC 
When you connect your camera (or insert the memory chip) 
into your computer Picasa will sense this and ask you what to 
do. If this does not happen you can open Picasa and click on 
IMPORT. 
 
If you do not want this option you can click on Tools/Options, 
click on the General tab and tick (or untick) Automatically 
Detect Media. Check the other 
options while you are there too!  
 
You can always press the IMPORT 
button if nothing happened and 
Picasa will go straight to your new 
photos if the chip/camera is 
correctly connected. 
 



Exclude duplicates should be ticked, just in case you had 
pictures that were there the last time you did this. Although it 
is easiest to include all in the import tray, you can Exclude 
pictures by clicking on the picture and selecting Exclude. 
Press Finish and enter the title (ie. Water skiing with Joe) and 
the other optional fields. Click Finish again. 
 
At this point Picasa may ask you to remove the pictures from 
the media. If you say yes it will clear your chip ready for use 
again. Remember this also implies that if you want your 
photos printed in a shop the same afternoon they are not on the 
card any more! 
 
Do you know where your photos are going to when Picasa 
transfers them? Initially it ‘exports’ your photos to the 
MyPictures folder (inside MyDocuments) but you can change 
this if you need to: Click on the Tools menu, and select 
Options. Find it in the General tab as shown below, and 
change the location by clicking. 
 
Why would I change it? Only if you kept all your data in one 
folder for backup purposes, but most people would be happy 
for it to be where it is. 
 

Exercises 
Download and Install 
Picasa on your home 
computer from 
picasa.google.com.au 

 
Take at least 15 photos 
of your favourite 
subject. 

 
Import the photos into 
Picasa and remove 
them from the chip. 

 
For bonus points find 
the best photo and 

email it to theverybest@cotu.biz   
 
 
 
 
 



Organising Photos in Picasa 

In Brief 
You should see your 
photos clearly 
organised in folders 
now. Notice the 
zoom slider on the 
right bottom of the 
picture tray. Click 

and drag the slide to get smaller and larger thumbnail pictures. 
 
If you need to move pictures to different folders you can click 
and drag the thumbnail image to the folder you like it to be in.  
If there are no more photos left in a folder Picasa will ask if it 
should delete the empty folder. This is generally advisable. 
 
Ordering the photos in a folder is also done with the click 
and drag method. The reason why you might want to order 
them is to prepare them for a slideshow. You can also split up 
a folder into two; just right-click on the first picture that you 
would like in a new folder and select Split Folder Here. You 
will be prompted for a new title. 
 
To delete a photo just click on the photo and press the delete 
key on your keyboard and confirm the deletion at the next 
prompt. 
 
Some cameras are smart and automatically 
align pictures according to orientation 
(landscape or portrait), but if your camera 
doesn’t do that then you can rotate the 
pictures by clicking the appropriate 
rotation button. 

 

Folders on Disk view 
This collection displays folders on your computer that contain 
pictures or films, sorted by date, with the original folder 
names as they appear on your computer's hard drive. Changes 
you make to the folders in this collection affects the matching 
folders on your computer's hard drive. Renaming a folder in 
Picasa is the same as renaming it in Windows Explorer. 
 



Which pictures and folders appear in 
Picasa?  
Only folders that Picasa is configured to scan appear in this 
collection. To modify where Picasa scans for pictures, select 
‘Folder Manager’ on the ‘Tools’ menu. Use the settings there 
to select or de-select the folders Picasa scans, choosing from 
these options: ‘Scan Once,’ ‘Remove From Picasa’ and 
‘Watch For Changes.’ 

Moving pictures between folders.  
Select a picture. With your mouse, drag and drop the picture to 
its new folder. To select more than one picture, hold down the 
Shift key on your keyboard as you select pictures. If you move 
a picture into a different folder on disk, Picasa will remind you 
that you are about to move the actual file on your computer's 
hard drive. Click the ‘OK’ button to move the picture to a new 
location. Note: Moving pictures between folders in the 
‘Folders on Disk’ collection will affect their physical location 
on your hard drive. 
 

Editing folder descriptions.  
Double-click on the title of any folder to open the Folder 
Properties box. Enter the new description. You can also 
modify the folder's date, place taken, or caption. Any 
descriptive information you add will be searchable in Picasa. 
Click the ‘OK’ button. Changing the name of a folder in 
Picasa will change the name of the actual folder on your 
computer's hard drive. 
Delete a picture from a folder. Select a picture, then go to 
‘File’ > ‘Delete,’ or just hit the Delete key on your keyboard. 
Picasa will remind you that you are about to send that file to 
your computer's wastebasket. Click the ‘OK’ button to remove 
the picture. 
 

Labels Collection 
This collection contains labels that you create in Picasa. 
Labels are used to group and organise pictures based on your 
own criteria and identified by a simple word or title. For 
example, you can create a label called ‘Flowers’ to group all 
your pictures of flowers, or you might create a label like ‘Trip 
to the seaside’ to arrange all your latest holiday snaps. Unlike 
the ‘Folders on Disk’ collection, which matches exactly the 
folder locations on your computer, labels do not correspond to 
physical folders on your hard drive. If you delete or move 
pictures inside the labels collection, the original files stay safe 
in their original locations on your hard drive. You can even 
add the same image to multiple labels without creating 



multiple copies of the same image. Edits you make to a picture 
will also be applied to every instance of the image, including 
the original. 
 
Create a new label. First select one or more pictures (you 
cannot create an empty label). Select ‘File’ > ‘New Label’ to 
create a new label in Picasa containing the selected picture(s). 
You can do the same thing by choosing a picture, clicking the 
‘Label’ button and selecting ‘New Label’ on the popup list. 
Add an existing label to a picture. The same picture can be 
assigned many labels in Picasa. Select a picture, click the 
‘Label’ button, and select an existing label from the list. 
Change a label description. Double-click on the title of any 
label to open the ‘Label Properties’ box. Enter a new 
description for the label. You can also modify the label's date, 
place taken, or caption. Any descriptive information you add 
will be searchable in Picasa. When you have finished, click 
the ‘OK’ button 
Delete a picture from a label. Select a picture. Right-click 
with your mouse and select ‘Remove from Label’ in the 
context menu or press the Delete key on your keyboard. Note: 
Deleting a picture from a label does not delete the original file 
from your computer's hard drive. 
 
Rearrange pictures in a label or between labels. Click and drag 
a picture to change its order within a label or drag it into 
another label to add it to that label. This does not affect the 
order in which the original files are stored on your computer. 
 

Labels Collection 
This collection contains the labels that you created earlier.  

Photo-editing Tasks 
Why would we want to edit a photo? 
 
A good photographer thinks about his picture before he takes 
it. They frame it correctly and position the subjects correctly, 
and do not stuff up! They also take 5 rolls of film and are 
continuously in your face. If you walk with them they need to 
stop and get out the tripod, and take ten different shots of the 
same view before walking another hundred meters only to 
repeat the performance. Are you a good photographer? If not, 
and your are an amateur or a beginner, then you may need to 
occasionally rescue a photo. You may have taken 100 photos 
that night of the reunion, but only one had the important 
people in it. So how do we fix photos? 
 



Am I changing the originals? 
 
Picasa was designed to be non-destructive to your original 
pictures. This is why edits and changes made to pictures in 
Picasa do not change the original picture files. 
 
Certain elements of changes you make to pictures or albums in 
Picasa only will exist in Picasa.  
 
Edits made to pictures only exist in Picasa until you export the 
pictures. Exporting pictures you have made changes to will 
create a new duplicate JPG with the edits included.  
 
If you want your picture files to be arranged in Windows to 
match your album structure, you can rename the picture files. 
The easiest way to do this is to add numbers sequentially at 
the beginning of your file names.  
 
Picasa does allow you to rename pictures. Order the pictures 
as you want them, then click ‘All’ next to ‘Select:.’ All 
thumbnails should be highlighted. Click ‘File’ > ‘Rename.’ 
Enter one word, like the Folder title. Your pictures will be 
renamed to that title, but numbered sequentially. 
 

The Basics 
 
What types of editing features are in Picasa?  
Picasa lets you fix common problems and create great effects 
in your photos. There are three editing tabs filled with tools to 
help you improve your pictures. 
 
‘Basic Fixes’ tab - These are buttons that work in one to two 
clicks to remove red-eye, crop, auto colour, auto contrast, 
straighten and fill light pictures. (There's also a Google-
inspired ‘I'm Feeling Lucky’ button here that takes the 
guesswork out and enhances pictures automatically. Try it and 
see what happens.) 
 
‘Effects tab’ - Effects are designed to help you turn a grey sky 
blue, brighten colours, and add photographic filters. There are 
12 effects to chose from in Picasa including ‘Sharpen’, 
‘Sepia’, ‘Black and White’ (B&W), ‘Warmify’, ‘Film Grain’, 
‘Tint’, ‘Saturation’, ‘Soft Focus’, ‘Glow’, ‘Filtered B&W’, 
‘Focal B&W’, and ‘Graduated Tint.’ 
 
‘Tuning’ tab - Here you will find the most advanced editing 
features to fix contrast and remove colour cast. Select from fill 
light, highlight, shadows, colour temperature, and the neutral 



colour dropper. 
 
If you wish to use editing features that are not available in 
Picasa, you can also easily access other image editing software 
from within Picasa. 
 
To edit your pictures in other image editing application: 
 
1. In Picasa highlight the picture you would like to edit. 
2. Choose ‘File’ from the Picasa menu on the top of your 
screen. 
3. Choose Open File. 
4. Your default image editing application will open and 
display your selected picture. Right-click on the picture, and 
chose ‘Open With’ to choose from a list of available 
applications. 

Cropping 
Your picture is fine, but the subject is too small. We like to cut 
out a certain section of the photograph. This is called 
cropping. 
To crop a picture in Picasa, please do the following: 
 
1. Double-click the picture in the folder or label that you wish 
to crop. This will open the picture in the ‘Edit Picture’ 
window. 
 
2. Click the ‘Basic Fixes’ tab (top-left) if it's not already 
showing. 
 
3. Click the ‘Crop’ button on the left. 
 
4. Select the crop size you want (4 x 6, 5 x 7, 8 x 10, or 
manual). The manual selection will allow you to perform 
custom crops. 
 
5. Click and drag your mouse over the part of the image you 
wish to crop. Cropping always creates a rectangular form. It is 
recommended that you use a starting point in the upper left of 
the picture. Click the left mouse button, hold it down, and drag 
the mouse until you have cropped the picture appropriately. 
 
6. If you make a mistake, click ‘Cancel.’ Just click the ‘Crop’ 
button again to start over. 
 
7. When you have cropped the picture the way you want it, 
click ‘OK.’ 
 
If you want to create a cropped copy of your JPG, click 



‘Export’ to save the cropped image to the location you like to 
have a cropped copy somewhere else. 
 

Red-eye Reduction 
 
It is important to note that Red-Eye will literally only remove 
red. Some eyes will appear yellow, white, or even green. This 
is very common when photographing pets. Picasa cannot fix 
these kinds of flash issues. 
 
To access ‘Red-Eye removal’, double-click the desired picture 
to bring it up in the ‘Edit’ view. Click the ‘Basic Fixes’ tab, 
then click ‘Red-Eye.’ 
 
Click, hold, and drag the mouse around each eye select it. A 
box will appear in the area you dragged through; try to draw 
as small an area as possible for better results. Release the 
mouse to complete your selection. The picture is displayed 
with the red-eye removed. 
 
To restore the original picture, click ‘Undo.’ To exit ‘Red-Eye 
Repair’ view and leave the picture unchanged, click ‘Cancel.’ 
The ‘Edit Picture’ view appears. Click ‘OK’ to apply your 
changes.  
 
Picasa preserves the original picture which enables you to 
undo the changes you make. The red-eye changes you make to 
the picture can be undone. If you are still in Red-Eye mode 
and want to undo, hit ‘Reset>Cancel.’ If you are out of Red-
Eye mode you can use the ‘Undo’ button. There is a Yes/No 
confirm dialogue. 
 

How can I change the colour in my photo's?  
‘Colour Temperature’:  This slider ‘warms up’ or ‘cools 
down’ the colours in a picture. Pictures taken in incandescent 
light often appear too warm, and pictures taken outdoors in 
sunlight may have a blue hue. Use this slider to fix both. 
 
 
‘Neutral Colour Picker’:  This eyedropper tool allows the 
user to manually set the correct 
white balance and remove colour 
cast by clicking on a neutral colour 
in the photograph (such as a white 
wall or a white shirt). Click on the 
Magic button for Picasa to suggest 
the best setting.  
‘Magic Contrast’:  works just like 



‘Auto Contrast’, but allows you to adjust the levels for precise 
control. Click the ‘Magic Contrast’ wand button for suggested 
contrast levels, then drag the sliders to get the best looking 
result.  
 

Showing your Photos 
 
Slideshow 
Select a folder or label and click the ‘Slideshow’ button. This 
will open the slideshow player. Click the onscreen ‘Play’ 
button to start the slideshow and make the player's controls 
disappear. You can hit the spacebar key on your keyboard or 
simply move your mouse to make the slideshow controls 
reappear at any time while your slideshow is playing. You can 
rotate pictures in the slideshow mode, add a star rating, and 
change the time duration that each slide is displayed. Hit the 
Escape key on your keyboard to stop the slideshow and return 
to the Picasa main library screen. 
 
You might like to Star a picture so that you remember which 
one you liked particularly much. The star will appear under 
the photo in your album list so you can easily find it back. 
 

Email (Internet access required) 
The ‘Email’ button in Picasa lets you email the photos in your 
‘Picture Tray’ in several ways: 
 

Default Email:  
Select this to send pictures using your computer's default 
email client (usually this will be Outlook). 

Gmail:  
Works with an existing Gmail account from Google (not 
included with your Picasa software). Sends up to 10MB of 
photos, including the message, compressed perfectly to a size 
that your friends will be able to open. 

Collage 
Click the ‘Collage’ button to quickly make personalised 
picture collages from a variety of templates including picture 
pile, picture grid, or contact sheet. You can also create a film-
style multiple exposure effect. To save your new creation, pick 
a background for your collage (use a picture or the colours 
black, white or grey) and specify how you want it created (as a 
screensaver, as a desktop background, or as a folder you 
select). 



 
Exercise: 
Clean up one of your favourite pictures and email it using 
Picasa to photocomp@cotu.biz  

Blogger (Internet access required):  
A blog is an online web journal. You can publish pictures to 
the web for free using Picasa and a blog that you create on 
Blogger.com. Simply select pictures (they will appear in the 
‘Picture Tray’) and click the ‘Blogger’ button. This will open 
Hello, with the Hello username Bloggerbot active. Bloggerbot 
is not a normal buddy on your Hello Friends list; it is a 
transfer tool that uploads pictures to your blog. With the 
Bloggerbot tab open, type in a caption where indicated and 
click ‘Publish.’ Your photo will be uploaded to your blog as 
the newest post. If you do not have a blog, click the ‘Blogger’ 
button in Picasa and follow the instructions to sign up for a 
free account (it only takes a few minutes). Once you have an 
account with Blogger, you will be able to click the ‘Blogger’ 
button in Picasa at any time to post pictures in one step. 
 
Exercise: 
Clean up several of your favourite pictures and post them on 
your own blog using Picasa. It is important you do this 
exercise now as it is not difficult to do and lots of fun. If you 
do not do it now you will surely regret it later! 

Order (Internet access required):  
Click the ‘Order’ button to order prints from one of Picasa's 
online print providers. Select Country on the left. Choose a 
provider by clicking on the logo or link. You will be prompted 
to sign in, using the username and password you normally use 
to access that provider's website. After you sign in, Picasa will 
automatically upload all the pictures in your ‘Picture Tray.’  
 
If you wish to send photos to friends overseas use a provider 
in their country! When using the Australian (Kodak) option it 
will give you the choice to get them send directly to you or for 
you to pick them up at your favourite local store! 
 
Picasa will upload a large file for each photo you wish to 
print, so a fast internet service is desirable! This service is 
ideal for enlargements 
 
Export 
Click the ‘Export’ button to save any pictures in the ‘Picture 
Tray’ as new JPEG files. For example, if you make a label 
containing pictures of your dog from various folders and then 
edit them to all be black and white, you will need to export 



that entire album and create new files on your hard drive that 
reflect those edits. You can choose the JPEG quality and saved 
picture size here, too. Note: Picasa never overwrites your 
original file on disk; any edits you make to a picture are only 
saved inside Picasa until you decide to save them as a new file 
when you export. 
 

Create a gift CD  
Creating a gift CD/DVD allows you to copy your pictures to a 
CD or DVD that you can give to friends or family. With a gift 
CD/DVD, you can also include an auto running slideshow and 
a copy of the Picasa installer, so you can share the software. 
 
1. Select the pictures you wish to copy to a gift CD/DVD. 
2. Click ‘Gift CD’ button. 
3. If you want to include the auto-running slideshow, make 
sure ‘Include Slideshow’ is ticked. 
4. If you wish to include a copy of Picasa on the CD/DVD, 
make sure ‘Include Picasa’ is ticked. 
5. You can add more pictures to the gift CD by clicking the 
‘Add More’ button. 
6. If you wish to resize the pictures, you can do so using the 
‘Picture Size’ drop down. If you do not wish to resize your 
pictures, make sure to select ‘Original Size’. 
7. Enter a name or title for your gift CD. 
8. When you are ready, click ‘Burn Disc’ button. 
 
If you only want to give the intended recipient the straight 
picture files, untick ‘Include Slideshow’ and ‘Include Picasa’. 
This will burn the folders of your pictures. This format might 
be a good idea if you want to take the CD to a photo lab to 
have the pictures printed. 
 
When Picasa is creating the image to be burned to the CD or 
DVD, Picasa will show ‘Calculating’ in the blue bar above the 
‘Burn Disc’ button. Please wait until this message goes away 
(it should state how many files and folders are ready to be 
burned) before pressing the ‘Burn Disc’ button.  
 
Exercise: 
Select all the photos you wish to backup and make a DVD or 
CD using the Picasa software. 
 
 
Finally 
At this point you have learned a lot about Picasa. It is 
important to understand that there are numerous different 
types of software that will do similar functions, and often 
better. It is difficult to find one package to suit all. Now that 



you have become familiar with Picasa you can look further 
afield and try different solutions if you have the need for it. 
 
For those of you who wish to enhance your photos more, or 
prepare photos for calendars or invitation you may wish to 
look at:  
 
Corel Paint Shop Pro 
Adobe Photoshop 
Adobe Photoshop Elements 
Microsoft Digital Image Suite 2006 
Photo Story 
Ulead PhotoImpact 
 
 
Adobe Photoshop Elements has been used by Adult Education 
For this course in the past, and comes with good 
recommendations! 
 
 
 
 
 
 
 
  



Glossary  
Sourced from www.shortcourses.com:  

 
Angle of view. The amount of a scene that can be recorded by 

a particular lens; determined by the focal length of the 
lens. 

Adapter. Used to insert a smaller storage device into a larger 
slot in a computer or other device. 

Aperture, maximum. The largest size of the hole though 
which light enters the camera. 

Aperture. The lens opening formed by the iris diaphragm 
inside the lens. The size of the hole can be made larger 
or smaller by the autofocus system or a manual 
control. 

Aspect ratio. The ratio between the width and height of an 
image or image sensor. 

ATA . A standard for storage devices that lets them be treated 
as if they were hard drives on the system. Any ATA 
compatible media can be read by any ATA device. 

Attachment. A file such as a photography sent along with an 
e-mail message so it can be viewed or saved at the 
recipient's end. 

Automatic exposure. A mode of camera operation in which 
the camera automatically adjusts the aperture, shutter 
speed, or both for proper exposure. 

Automatic flash. An electronic flash unit with a light-
sensitive cell that determines the length of the flash for 
proper exposure by measuring the light reflected back 
from the subject. 

Back-lit . The subject is illuminated from behind and will be 
underexposed unless you use fill flash or exposure 
compensation.  

Bit-mapped. Images formed from pixels with each pixel a 
shade of grey or colour. Using 24-bit colour, each 
pixel can be set to any one of 16 million colours. 

Burst mode. The ability of a camera to take one picture after 
another as long as you hold down the shutter release 
button. 

Card. The sealed package containing storage chips or other 
devices with electrical connectors that make contact 
when inserted into a card slot on a camera, printer, 
computer, or other device.. 

Colour balance. The overall accuracy with which the colours 
in a photograph match or are capable of matching 
those in the original scene. 

Colour depth. The number of bits assigned to each pixel in 
the image and the number of colours that can be 
created from those bits. True Colour uses 24 bits per 
pixel to render 16 million colours. 



CompactFlash. A popular form of flash storage for digital 
cameras. 

Compression. The process of reducing the size of a file. 
Depth of field. The distance between the nearest and farthest 

points that appear in acceptably sharp focus in a 
photograph. Depth of field varies with lens aperture, 
focal length, and camera-to-subject distance. 

Docking station. A small base connected to the computer by a 
cable. You insert the camera or other device into the 
docking station to transfer images. 

Download. Sending a file from another device to your 
computer. 

Exposure. 1. The act of allowing light to strike a light-
sensitive surface. 2. The amount of light reaching the 
image sensor, controlled by the combination of 
aperture and shutter speed. 

Flash card reader. An accessory that attaches to your 
computer by cable. You insert a flash memory card 
into the reader to transfer files. 

Flash memory card. A card containing chips that store 
images. 

Flash memory. A form of memory using chips instead of 
magnetic media. The data in the device isn't lost when 
the power is turned off. 

Flash, fill. Flash used to fill shadows even when there is 
enough light to otherwise take the photograph. 

FlashPix. An image format that contains a number of 
resolutions, each of which is broken into tiles that can 
be edited and displayed independently. 

Floppy drive. A storage device on almost all computers that 
accepts 3 « or 5 ¬-inch floppy disks. 

Focal length. The distance from the optical center of the lens 
to the image sensor when the lens is focused on 
infinity. The focal length is usually expressed in 
millimetres (mm) and determines the angle of view 
(how much of the scene can be included in the picture) 
and the size of objects in the image. The longer the 
focal length, the narrower the angle of view and the 
more that objects are magnified. 

Focus. The process of bringing one plane of the scene into 
sharp focus on the image sensor. 

F-stop. A numerical designation (f/2, f 2.8, etc.) indicating the 
size of the aperture (lens opening). 

GIF. An image file format designed for display of line art on 
the Web. 

Gray market. Importing camera equipment outside of the 
normal manufacturer's distribution channels to take 
advantage of lower prices elsewhere in the world. 

Gray scale. A series of 256 tones raging from pure white to 
pure black. 



Guide number. A rating of a flash's power. 
Image sensor. A solid-state device containing a photosite for 

each pixel in the image. Each photosite records the 
brightness of the light that strikes it during an 
exposure. 

JPEG. A very popular digital camera file format that uses 
lossy compression to reduce file sizes. Developed by 
the Joint Photographic Experts Group. 

Landscape mode. Holding the camera in its normal 
orientation to hake a horizontally oriented photograph. 

Long-focal-length lens (telephoto lens). A lens that provides 
a narrow angle of view of a scene, including less of a 
scene than a lens of normal focal length and therefore 
magnifying objects in the image. 

Macro mode. A lens mode that allows you to get very close 
to objects so they appear greatly enlarged in the 
picture. 

Megapixel. An image or image sensor with over one million 
pixels. 

Memory stick. A flash memory storage device developed by 
Sony. 

Multi-megapixel. An image or image sensor with over two 
million pixels. 

Multiple exposure mode. A mode that lets you superimpose 
one image on top of another. 

Multiple exposure. An image made up of two or more images 
superimposed in the camera. 

NiCad. Nickel cadmium battery. 
Noise. Pixels on the image sensor that misread the light. 
Normal-focal-length lens. A lens that provides about the 

same angle of view of a scene as the human eye and 
that does not seem to magnify or diminish the size of 
objects in the image unduly. 

Open up. To increase the size of the lens aperture. The 
opposite of stop down. 

Operating system. The program that controls the camera's or 
computer's hardware. 

Orientation sensor. A sensor that knows when you turn the 
camera to take a vertical shot and rotates the picture so 
it won't be displayed on it's side when you view it. 

Overexposure. Exposing the image sensor to more light than 
is needed to render the scene as the eye sees it. Results 
in a too light photograph. 

Panorama. A photograph with much wider horizontal 
coverage that a normal photograph, up to 360-degrees 
and more. 

Panoramic mode. A digital camera mode that uses just the 
center band on the image sensor to capture an image 
that is much wider than it is tall. 



Parallel port. A port on the computer that is faster than a 
serial port but slower than SCSI, USB, or IEEE 1394 
ports. Often used by printers and flash card readers. 

PC card. A card, in the case of cameras usually a storage 
device, that plugs into a slot in a notebook or hand-
held computer. Originally called PCMCIA cards. 

Pixelization. An effect seen when you enlarge a digital image 
too much and the pixels become obvious. 

Pixels. The small picture elements that make up a digital 
photograph.  

Port. An electrical connection on the computer into which a 
cable can be plugged so the computer can 
communicate with another device such as a printer or 
modem. 

Portrait mode. Turning the camera to take a vertically 
oriented photograph.  

Preview screen. A small LCD display screen on the back of 
the camera used to compose or look at photographs. 

Red-eye reduction mode. A mode that fires a preliminary 
flash to close the iris of the eye before firing the main 
flash to take the picture. 

Red-eye. An effect that causes peoples eyes to look red in 
flash exposures. 

Refresh rate. The time it takes the camera to capture the 
image after you press the shutter release. 

Removable media. Storage media that can be removed from 
the camera. 

Resolution. An indication of the sharpness of images on a 
printout or the display screen. It is based on the 
number and density of the pixels used. The more pixels 
used in an image, the more detail can be seen and the 
higher the image's resolution. 

RGB. The colour system used in most digital cameras where 
red, green, and blue light is captured separately and 
then combined to create a full colour image. 

Scanner. An input device that uses light to read printed 
information including text, graphics, and bar codes, 
and transfers it into the computer in a digital format. 

Shutter Speed. The length of time the shutter is open and 
light strikes the image sensor. 

Shutter. The device in the camera that opens and closes to let 
light from the scene strike the image sensor and expose 
the image. 

SLR. A type of camera with one lens which is used both for 
viewing and taking the picture. 

SmartMedia. A popular form of flash memory card. 
TIFF . A popular image format used in digital photography. 
Time-lapse photography. Taking a series of pictures at preset 

intervals to show such things as flower blossoms 
opening. 



Underexposure. Exposing the film to less light than is needed 
to render the scene as the eye sees it. Results in a too 
dark photograph. 

Upload. Sending a file from your computer to another device. 
URL (Uniform Resource Locator). The address of a Web site. 
USB port. A high-speed port that lets you daisy-chain devices 

(connect one device to another). 
VGA. A resolution of 640 x 480. 
Video card. A card the fits into a computer's expansion slot so 

you can edit digital video. 
Viewfinder. A separate window on the camera through which 

you look to compose images. 
Wide-angle lens. See Short-focal-length lens. 
Zoom lens. A lens that lets you change focal lengths on the 

fly. 
 


